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Network Guardian software licence agreement 

Please read this agreement before using this software. By using the software. you accept the licence 
conditions If you are unwilling or unable to accept this agreement, promptly re tu m the package 

(unused) to your supplier for a full refund. 

G rant of licence . 
In consideration of and subject to your payment for this software, and subJect to your agreemg to 
abide by the terms of this licence agreement, Question Mark Comp~ting Limited (QMCL) gr~ts you 
a non-exclusive, non-transferable licence to use the Network Guard1an software under the ~1m1tat1o~s 
set out below. This licence is separate and additional to your licence agreement for the mam Q.uestton 
Mark Designer for Windows software, which you need to have 1n order to use Guardian effecti vely. 

The Guardian software (file GUARDIAN.EXE) may be used by one perso~ at a t~~e only For use 
on a computer not attached to a network, the software is cons1der~d to be 1n use 1f any part of 11 IS 

either loaded 1n memory or virtual memory, or stored on a hard d1sk or other ~torage dev1ce. You 
must not allow two occasions of "in use" on different computers at the same time 

On 8 network, the software will normally be stored on a server computer and ~oaded to ~un on 
another computer, representing two occasions of "in use" as defined above. Th1s 1s perm tiled 
provided that you allocate a single physical computer on the network as the sole comp~ter that may 
be used to load and run the software. You may change th1s allocation only on an occas10nal bas1s. 
The software may not be loaded or run on other non-allocated computers on the network Should you 
need to run the software on more than one computer on a network, you must purchase an extended 

licence 

Additionally, you may make one copy of the program d1sk for back-up purposes 

Ownership . 
The software tncludmg user documentation 1s copynght QMCL On purchase, you acqu1re tlt.le to the 
physical packaging, 1ncludtng disk(s), but the software and any cop1es made of the software 1n any 

form and on any media rema1n the property of QMCL 

You may not copy the user documentation All cop1es of the soft~are made must mclude the 
copyright notice. You agree to effect and maintain adequate secunty measures to safeguard the 
software from thef\ or unauthonsed access, and you understand that the software mcludes confidenttal 
information belonging to QMCL, and you accept that you owe QMCL a duty of confidence m 

relation to this information. 

You may not sub-ltcence, rent, lease, sell or re-sell any of the software in any .way in. whole or part, 
either temporari ly or permanently. In particular you may .not put the software 1nto a ltbrary. for 
borrowing, even Within a college library Except as permitted .by law, you may not decomp1le, 
translate, reverse engmeer, create a derivative work or otherw1se use or copy the software or any part 

of 11, unless perm1tted wtthin th1s agreement. 
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Limited warranty 
We, QMCL, warrant that the disk(s) on whtch the software is provided are free from defects in 
materials or workmanship for a period of 90 days from your purchase. We shall replace any disk 
which does not meet this warranty and wh1ch is returned to us within such period. Apart from thts 
warranty the soflware and manual are both supplied "as is" without any condition or warranty, 
express or implied, statutory or otherwise, as to quality or fitness for any purpose or for error-free 
operation. Because of the diversity of conditions and hardware under which the software may be 
used, you are advtsed to test it thoroughly before relytng on tt. In no event will we be responsible for 
any loss or damage whatever or however caused (including but not limited to economic or 
consequential loss) anstng d1rectly or tndirectly 1n connection with the software and/or manual , their 
use or misuse or otherwise, except for liability in respect of death or personal injury caused by our 
negligence or that of others for whom we are legally respons1ble or for any other liability which it is 
unlawful to exclude. 

Under no circumstances will QMCL's liability exceed the pnce p&Jd for the product. We will offer 
free telephone support to deal wtth any problems with the software in normal business hours for a 
period within 90 days from your purchase We may offer free support thereafter, but we are not 
contractually obltged to . 

Term 
This licence is effective until terminated You may terminate it at any time by destroying all the 
copies of the soflware and documentation. QMCL will have the right to terminate your licence 
immediately if you are in material breach of any of its terms. Upon such termination, you must 
destroy al l and any copies of the software and documentation. 

Gen eral 
This agreement is the entire agreement between the parties, and QMCL does not accept any variation 
of these terms including any purportedly made by any purchase order or other document used by you. 
This agreement may only be superseded by a written agreement signed by a director of QM CL, or by 
an authorised overseas distributor. You may not assign this licence agreement without QMCL's prior 
written consent. No delay or omission of QMCL in exercistng any right or remedy in whole or part 
shall be construed as a waiver of it, to operate so as to limi t or preclude any further or other exercise 
of it. This agreement shall be governed by and construed in all respects in accordance with English 
Law. 

Ill 
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1. 

1.1 

1.1.1 

Getting started 

Introduction 

What is Guardian? 

The Question Mark Network Guardian (or Guardian for short) 
is an add-on program to Question Mark Designer for Windows 
that lets you control and secure access to tests. 

Guardian is primarily aimed at network users of Question Mark 
who need to control which students can access which tests 
when. However it can also be used on standalone PCs, or when 
distributing material at a distance, when you want to control 
which tests are available to run, how many times they can be 
done, and in what order. 

These are some of the potential security problems you can help 
resolve with Guardian. 

You may want to allow certain users or groups of users 
access to some tests only, and prevent access to other 
tests. 

This is the essence of what Guardian does, assigning 
users a list of tests they are allowed to do. 

You may be worried that people will answer tests giving a 
false name (eg "Santa Claus''). 

With Guardian, you can define a list of valid user names 
with a password assigned to each. People can only run 
tests if they quote their name and password. 

You may want to stop a user from being able to do a test 
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more than once. 

You can set with Guardian that a test can only be done 
once (or twice or any other number of times). 

You may be worrted that people wt/1 try and nm a test 
before it is released, or after 11 has expired. 

With Guardian, you can define date and llme ranges 
within which a test is valid. 

You may want to make sure that u.~ers cannot auempt an 
advanc:ed test withuul pa.wng a .<11mpler one flr.~t. 

You can give tests priorities in Guardian, and the high 
priority tests must be done before the lower priority ones 

You may wtmt to keep a relwhle record of who does what 
test and what score they get, and prevent un.~crupulous 
users from al/emptmg a test and trying to hide thts from 
you (eg by deleting I he answer file or turning off thetr 
machine). 

Guardian can store all test results in a key file, and let 
you see at a glance who has done what test. Guardian 
also Jets you control which directory each test saves its 
answer files in. which helps security and organisation. 

You may want to asstgn users to different groups .~o that 
you can lr>ok at results on a group ha.n.v. 

You can easily assign users to groups within Guardian, 
and group information is stored in the answer file and is 
available in reporting with the Reporter software. 
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1.1.2 

1.2 

J .2.1 

Introduction to this manual 

Section 1.2 describes some general concepts in using Guardian 
and section 1.3 describes how to install the software. Section 
J 4 gives you some ideas on how to get started using the 
software. 

Chapter 2 describes the core part of Guardian, how you can 
create and edit a key file . Chapter 3 describes how Presenter 
works with key files created by Guardian. Chapter 4 describes 
how you can use Guard ian to review results information. 

Appendix A includes some examples of use of Guardian; 
Appendix 8 contains some notes on securi ty, and Appendix C 
gives some suggestions for trouble-shooting Appendix D gives 
a reference listing of the Guardian menus. 

If security is important to you, please read this manual carefully 
so as to make your testing system as secure as possible. You 
are also advised to restrict access to the Guardian program to 
people who need to use it. Guardian is a security product. and 
access to it and to this manual by people you are trying to 
secure agajnst would be unhelpfu l 

Please make sure you look at the text G_READ.ME file which 
is on the distribution disk, for any last minute infonnation on 
Guardian. 

General concepts 

How Guardian works 

Without Guardian, Presenter (the Question Mark Designer for 
Windows test delivery sofiware) offers the user a choice of all 
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1.2.2 

Users 

Tests 

test files on one directory. Or else you can set up Presenter to 
run one test file by naming the tile on the command line. 

With Guardian, you can make Presenter ask the user his/her 
name and then, provided the name is checked as being valid, 
offer the user a list of tests that you want him/her to 
individually answer. 

In order to define the names and tests, you create a "key" file 
with Guardian. This lists the users and tests and who can do 
what. Presenter then reads the key file, and only offers the tests 
permitted in it. 

The Guardian software works only with the Windows version 
of Question Mark and does not control access to DOS or 
Macintosh tests (except DOS tests called as external tests under 
the Windows software) 

Key files 

Key files are encrypted. password-protected, proprietary files 
with extension .QDK. A key file consists of users, tests and 
instances of users being scheduled to or having done tests, 

A key file can contain up to I 000 users (or students). 

For each user, you define a name (up to 16 characters) and an 
optional password and group 

A key file can reference up to 60 test files, by file name and 
directory. 

For each test, you can define a date and time when the test 
becomes available and ceases to become avai lable. For 
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Scheduling 

example. you could set that a test becomes available on the I st 
September at I Oam, and is no longer available after 30th 
September at 5pm. 

You can also define how many times a user can do a test. 
whether unrestricted, a specific number of times (eg once, 
twice) or until a certain score is reached. 

Once you have defined users and tests, you can schedule users 
to tests. ie assign the test to the user. 

You can schedule any number of users in the key file to any 
number of tests. 

For a simple use of Guardian, you may only want to create one 
key tile. You would put all your users and all your tests in it, 
and say who is allowed to do what test when. For a more 
complex use of Guardian, you may want to create several key 
tiles, for different groups or classes of user. Each key file 
would permit a certain group of users to do certain tests. 

1.2.3 Results and reporting 

Guardian also aids in helping you securely record test results. 
Firstly you can specify m the key file which directory the 
answer fi fe is saved to. 

However Guardian also records all test attempts and resulting 
scores in the key file . Thus the key file not only records who 
can do which test, but who has done which test. Tbjs is a very 
powerful adjunct to the reporting system, and allows you to use 
Guardian as an addition to Reporter. as well as for its primary 
security functions. 

5 



Network Guardian Getting started 

1.2.4 

1.2.5 

(If you prefer, you can choose to make key files "read only", 
which means they do not record the results information. Th1s 
may be appropriate if your network policy does not permit 
server files to be written to by student PCs, or if you do not 
need or want the information.) 

Locking a test file 

All the Guardian security features arise because Presenter reads 
the key file and acts on it. An obvious loophole for an 
unscrupulous user would be to delete the key file or hide it 
from Presenter, and then just run Presenter ordinarily and run 
the tests without the controls in the key file. 

In order to prevent this, Guardian gives you the capability to 
"lock" test fi les. If a test file is locked, then Presenter will only 
run the test via a key file. If a user tries to access a locked file 
without doing so via a key file made by Guardian, Presenter 
refuses to run it. 

You will usually want to lock all test files used with Guardian 
to ensure access only via the key file. 

User groups 

Guardian introduces the ability to band users into groups. These 
groups can represent classes, branches, or any other division of 
users into categories which you find useful 

A group is defined by a group name, which can be up to 16 
characters long. 

You can use groups Within Guardian to make it easy to 
schedule similar users to the same test. Group names are also 
stored in the answer files created, and are included in reports 
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1.3 

1.3.1 

1.3.2 

and database exports. 

Installing Guardian 

What you need to run Guardian 

To use Guardian, you need a copy of Question Mark Designer 
for Windows, Version 2.10 or greater. 

You use the standard Designer software for creating tests 
and libraries. (Guardian also works with tests and libraries 
created w1th earlier vers1ons of Designer than 2. 10.) 

You then use the Guardian software to make key files to 
lock and control access to these test and library files. 

You use the standard Presenter software to look at the 
key files and run the tests. You must have a version of 
Presenter that is version 2.1 0 or higher in order to access 
the key files. 

You use the standard Reporter software to analyse and 
report on answer files created with tests. 

What the Guardian program consists of 

The Guardian distribution disk cootajns the following files: 

GUARDIAN.EXE, the program file that allows you to 
create, edit and view key files. 

QD_GUARD.HLP, the Guardian Windows help file . 

7 
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G READ.ME. a text file which contains last mjoute 
information on this release of Guardian. Please make sure 
to look at this file. 

SETUP.EXE, and other files with names starting with 
SETUP, which are the files for the automatic installation 
program for Guardian. 

1.3.3 Installing Guard ian au tomatically 

Before installing the Guardian software, you must first install 
the standard Question Mark Designer for Windows software. 
After this, you should do the following to install the Guardian 
software automatically. 

I. Put the Guardian distribution disk in drive A: or B:. 

2. Go into Windows File Manager, and click on drive A' or 
B:. 

3. Double-click on the file SETUP.EXE. This runs the 
automatic installation program, which loads the Guardian 
software into the same directory as Question Mark 
Designer for Windows is installed in, and creates an icon 
to run Guardian. 

1.3.4 Installing Gua rdian manua lly 

If you prefer to install the software manually. or if you have 
any problems with the automatic installation, simply use File 
Manager to copy GUARDIAN.EXE, QD_GUARD.HLP and 
G READ.ME from the distribution disk into your Question 
Mark directory. Then from Program Manager, use File I New 
to make a new program item in the Question Designer group to 
run GUARDIAN.EXE. 
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1.4 

The GUARDIAN.EXE program needs access to the DLL 
program fi les (TCLASS31 .DLL, OWL3 1.DLL and 
BC30RTL.DLL) that come with Designer. (f you decide to 
copy the Guardian software into a different directory to 
Designer. you should copy these files into this directory as 
well, or move them into your \WINDOWS\SYSTEM directory. 

Guardian stores its user interface settings between runs in file 
QD_GUARD.JNI on the \WfNDOWS directory. 

Tutorial on Guardian 

Here is a short tutorial that guides you through the process of 
creating a key file and using Guardian for the fLrst time. In 
order to run the tutorial, you should have installed the software 
on your Question Mark directory, and have at least one test in 
thls directory ready to run, perhaps one of the example tests 
supplied with the Question Mark standard software. 

We shall assume that you have four users, Adam, Bob. Charles 
and David, and you want to permit each user to do a test, with 
just a single attempt at the test aJiowed. 

1. Run the Guard ian software 

First, double-click on the Guardian icon to run the 
GUARDlAN.EXE program. (If the program does not run, then 
check that you have instaJJed the soflware correctly by 
carefully reading section 1.3 above.) 

9 
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2. Make a new key file 

Select File New or click on the toolbar icon to make a new 
key file. 

On the dialog you see as a result of this. you must define a 
name and password to control access to the key file. Anyone 
who wants to look at or edit the key file will need to quote 
what you put here. For this tutorial. just click on OK to accept 
the default name "anon". 

You then see two further dialogs allowing you to set an 
introduction message and customise logon dialogs, which we 
shall ignore in this tutorial. Click on OK at each dialog. 

3. Add some users Into the key file 

You should now see a screen with a window for users and a 
window for tests. with no users or tests defined. The Users 
window should be highlighted (if it is not. click on it). 

Add a user. by selecting User I Add, or clicking on the 
toolbar icon. You should see a dialog similar to the following. 

:. ' •• ot.ltl _, 
r 

c... 
a.-: 

~ 

,. • ...,c 

1-

Enter "Adam" as the name of the user. Leave the group box 
empty. The password is set by the software to a random string 
of letters. (You can disable this random generation of 
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passwords with Options Generate passwords, but for the 
moment leave this as it is.) 

Click on OK, and the same dialog box re-appears ask:ing for 
another user. Enter "Bob" as a user, and click on OK. Repeat 
with "Charles" and "David". 

Then, when the dialog box for adding a user comes up another 
time, click on Cancel to indicate that you don't want to add 
another user. 

The Users window should now have 4 users in it, Adam, Bob, 
Charles and David 

4. Print out the user list 

Next you should print out the list of users. Select all four users, 
either by clicking and dragging with the mouse, or using User 
I Select all. Then choose User I Information. which creates 
a report of information on users. 

Reports in Guardian work the same way as reports in the 
standard software (Reporter). A list of the users and passwords 
should be displayed in the Windows Notepad software. You can 
print it by selecting File I Print in Notepad, and then exit 
Notepad with File I Exit. 

(If you have any problems running Notepad or printing, do not 
worry about them at this stage. Just take a written note of the 
user names and randomly generated passwords. so you can use 
them later on in this tutorial ) 

5. Add a test Into the key file 

Now click on the Tests window to make it current. This should 

11 
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be visible on the screen - if you have problems finding it, select 
it from the Window menu. When the Tests window is 
highlighted, the Test menu becomes active. while the User 
menu is greyed out. At any one time, you can only have one of 
these two windows and menus current. 

Add a test to the key file by selecting Test I Add, or clicking 
on the toolbar icon. Choose on the file selection dialog one of 
the tests on your PC, perhaps the example quotations test 
supplied with Question Mark (file name EG2.QDT). 

This should give you a dialog similar to the following, which 
lets you define some details of how the test is to run. 

TutName 

jOuot•U.ne loet · who uld wflet? ~nlodcod 

TutAicneme 0 Uae Pllth 

jC!\OOESIGH\EG2.00T 

Anawer file .directory 

h &lrOwwt .. I I a, .. , n"'' ... J I &nemp-. ... 

Jjelp 

You need to restrict access to the test to a single attempt. To do 
this, press the Attempts button. Then in the dialog that 
follows, set limit number of attempts on, and make sure 
that Attempt numbe r of t imes is set to I (this should be tht.! 
default). 

Then click OK to leave this d1alog, and OK agam to leave the 
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6. 

next dialog, and then press Cancel to not add another test to 
the file. You should be back in the main Guardian window with 
the Tests window highlighted with one test in it. 

Schedule the users to do the test 

You have now added 4 users and I test to the key file, and you 
need to schedule the users to the test. There are three steps to 
scheduling. 

First, select the test you want to schedule. Click on the 
test you have just added to highlight it. 

Then select the users you want to schedule. Chck on the 
Users window to make it current, and then select and 
highlight all four users. (They should already be selected 
from step 4. above.) 

Once you have highlighted the users and the test. the 
Schedule menu should be available. If it is not, check 
that you have added users and a test, and that you have 
clicked on and selected both users and the test Then to 
make the scheduling happen, choose Schedule I 
Schedule or click on the toolbar icon. 

You should then see a message d1alog telling you that I test 
has been scheduled to 4 users. Click OK to dismiss this. 

7. Save the key file and exit Guardian 

Save the key tile, by choosing File I Save, using the name 
TEST.QDK on the Question Mark directory, usually 
\QDESIGN. Then exit Guardian with File I Exit. 

13 
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8. Run the tests from the key file 

You now should run Presenter to run the test from the key file 
You do this by double-clickmg on the Presenter icon, or if the 
icon is not available running it from File Manager. The first 
thing that should happen is that Presenter asks you to enter 
your name. Enter the name Adam, and when asked for a 
password, enter the password printed or noted at step 4 above 

You should then get a dialog offering one test to do, like the 
dialog below. Press Run, and go through the test, answering 
the questions, and finish the test. 

Que stion Mark Presenter Version 2.10 

Ad am 

Quotations te st - who said what? 

Bun ~xit 

!copyright 1Ci OuestJon Mark C~~p~tlng Ltd: 19iJJ - 1995) 

(If Presenter does not ask for a name, or else does not accept 
Adam, then please check that the file PRESENT.EXE, the key 
file TEST.QDK and the test file referenced (EG2.QDT or 
whatever) are all in your Question Mark directory (usually 
\QDESIGN). Also check there are no other key files on th is 
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directory. This should be the case unless you have been using 
Guardian to make other key files; 1f so, move the other ones to 
another directory, and move them back later if you need them.) 

After running the test, the software should return you to the 
Presenter dialog, with no tests available, as just one attempt 
was set up for each user. Press Exit to leave Presenter. 

Repeat the above process with users Bob and Charles. Each 
user is allowed access to the test just once. 

View the results in Guardian 

Then return to Guardian, and open the key file TEST QDK. 
You need to quote the name "anon" to get access to the file. 
Select all 4 users and select the test. so that all are highlighted. 

Then choose either User I Results or Test I Results, and 
look at the report. You should see that the fact that Adam, Bob 
and Charles have done the test is visible, as well as the fact that 
David is scheduled to do it but has not done it The scores 
achieved are also shown 

Guardian can be used to rev1ew results in tandem with the 
standard Reporter program. as well as to control access to tests. 

That IS the end of the tutorial - leave Guardian You may want 
to delete file TEST.QDK, or move it to another directory, so 
that it will not be picked up and used by Presenter every time 
Presenter is run. 
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2. 

2.1 

2 .1.1 

2.1.2 

Making a key file 

Using the Guardian software 

Running Guardian 

You create a key file with the GUARDIAN.EXE software. You 
run the Guardian software by doubJe.clicking on its icon, or in 
any of the other standard ways in which you run Windows 
programs. Guardian is an independent program that lets you 
create, edit and review key files. 

The user interface within Guardian is very similar to the user 
interface within Designer. You can see what each menu item or 
toolbar icon does by dragging the mouse over it, and looking at 
the status line. If you need help at any time, you can get it by 
pressing F1 or by clicktng on the Help menu. 

To exit the Guardian program. you use File I Exit. 

Opening, closing and saving files 

When you first run Guardian, you usually see a blank screen 

If you want to run Guardian so that it always opens the same 
key file when started, you can set this up by adding the name 
of the key fi le to the Program Manager command line attached 
to the Guardian icon. For example, a command line of 
"GUARDIAN.EXE KEY.QDK" wi ll always start Guardian witJ1 
key file KEY opened. 

You can open on ly one key file at a time. When you create or 

16 

Network Guardtan Making a key file 

2.1 .3 

open another one, the previous one is closed. (If you have made 
any changes, you are asked whether you want to save the 
previous file ) 

To create a new key lite, you use File I New 

To open an existing key file, you use File I Open. 

To save a file, you use File I Save. 

To save a file with a new name. you use File I Save 
As 

When you open a key file and change it, then while it is open, 
the file is protected so that no·one else can change lt. This 
prevents Presenter from using the unfinished information. 
Howe~er generally you should try and ensure that when you are 
accessmg the key file with Guardian, no·one else is trying to do 
so, as the automatiC locking mechanism may not be failsafe in 
all circumstances. 

The .QDK file name of the current key file is shown on the 
Guardian window caption, along with whether you have 
modified the file since last saving. 

If Options I Backup is set on, then whenever a key file is 
saved, the previous instance of the file is saved with the same 
name and a Q! K extension. You can recover the old file by 
renaming it to a file w1th a .QDK ex tension. 

Key file windows 

A key file contains two windows, one for users and one for 
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2.2 

2.2.1 

tests. The Users window shows all the users defined in the key 
file, and the Tests window shows all the tests. 

You can re-size these Windows and move them around the 
screen in the standard Windows ways. Very often you will want 
to set the screen so that you can see both windows. The easiest 
way of doing this is to select Window I Tile. 

The figure below shows an example Guardian screen. There are 
three users and one test. 

Pete r Jones 

General information in a key file 

Overview 

As well as the users. tests and scheduling, there is some general 
information defined in the key file. which is defined in three 
dialogs. 
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You can define security informatton (name and password) 
to control access to the key file, as described in section 
2.2.2. 

You can define an introduction message displayed in 
Presenter and information regardmg where answers are to 
be written, as described in section 2.2.3 

You can define the logon messages used in Presenter, eg 
for asking the user's name, as described in section 2.2.4 

When you use File I New to create a new key file, you are 
shown these three dialogs before adding users and tests to Lbe 
file. You can change the settings, or click on OK to accept the 
standard settings. 

You can return to these dialogs and change the information at 
any time while editing the file, using the three menu items File 
I Password. File l Introduction and File I Logon 
messages. 

Password dialog 

1t is vital that access to the key file is secure. If someone can 
read or change the key file , then all the security measures in the 
key file can be changed or altered 

UnJess you don't care about other people accessing tJ1e key tile, 
you must protect your key tile with a password. In fact, for 
extra security, Guardian lets you define a name and a password 
for the key file m this dialog box. 

You can enter up to 16 characters in the Enter your name 
box and up to 8 characters in the Enter your password box. 
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Key lite: pa:;sword 

Enter your name: I 
l myname 

-'an eel I 
Enter your password: ,_ 

J:lelp ) 

Every time you use Guardian to open the key file, you have to 
quote your chosen characters. No-one else can access the file 
without quoting them. (If you forget the name and password 
used, you too will be unable to access the key file.) 

You should use a password that no-one will guess. The name 
defaults to "anon", but for maximum security you should also 
change this to something people will not guess. 

To change this information at a later time (once the key tile is 
open), you use File I Password. 

Introduction dialog 

The next general dialog on creating a key file lets you define 
an introduction message that can be given to the user when 
being offered a choice of tests. and how results from the tests 
are saved. 
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Customise 
the 
introduction 
message: 

Default 
answer file 
directo ry : 

• t:l( hit lllllutJUt hUll dHi.J OII'..Wt:J•, 

Cuatomlse lhe lntro4uc:lfon oncaaaoc: JliC 
Run through oil three tuta In any order you dlooae. 

Tuto developed by Oue otlon lo4or1t Com,lltlng l.l4. 
lluocd 

ltall • oupcl\lloor K you hwc ony t~ucriu. ~felt~ 

Ocleult a newcr lllc dire dory. 

u.-· 
181 Write re oulto to l<cy lllc 

There are four lines of poss1ble introduction messages. You can 
fill these in, or keep them blank. Whatever you set will be 
displayed to the user on the initial Presenter screen, which 
displays the list of tests the user can choose from. 

You might want to include some information that te lls the user 
which tests are on offer, where the tests are from or what the 
user should do. 

The messages are automatically centred on the Presenter screen, 
with any blank lines omitted. 

You can define here a directory where answer files are saved 
in, when tests are run via this key file. You can use the 
Browse button to select a directory interactively 

Whatever you set here is used as the defaull directory. but you 
can change it for different tests, as described in section 2 .4. 1 on 
adding tests. (The answer file directory set when defin ing the 
test takes precedence over the directory set here.) If you leave 
this box blank, then the answer file directory defaults to the 
current Presenter directory. 
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Write result s 
to key file This check box defines whether results of tests taken are 

written to the key file. 

The default situation (box set on) means that every time 
someone does a test via the key file, this is recorded in the key 
file by Presenter. This means that you can use the fu ll facilities 
of Guardian, including results reporting, but the key file will 
contain all results of tests, and will expand in size to contain 
these. It also means that student PCs will write to the key file 
over the network, which may be discouraged on some network 
systems. 

lf you turn the box ofT, then Presenter does not amend the key 
file when a test is taken, which means that results are not stored 
in it. This means you cannot use Guardian to report on results, 
and you cannot restrict a user from only having limited 
attempts at a test (because there is no way of recording prior 
attempts) nor set test priorities. 

To change this information at a later time, you use File 
Introduct ion. 

2.2.4 Logon messages dia log 

The fi nal general screen presented to you on creating a key file 
is one that lets you define some messages used in Presenter. 
You can define the messages that ask the user his/her name and 
password in Presenter, and also the error messages given if the 
user entries are wrong. 

For each of the four messages in the dialog, you can define 
your own versions if you do not like the standard messages. For 
example, you might want "Enter your employee number" rather 
than "Enter your name". 
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2.3 

2.3.1 

Cuet.omlae 'Enter your neme:•; 

I Enler your name: I ~ 
I C.IIICCI 

Cwelomlec 'Enter your pan worot:•: 

IEmer yt ur panword: 

Cu11omloc 'Pauword fnQined': 

I Pauword lncerred 

To change this information at a later time, you use File 
Logon messages. 

Adding users into a key file 

User names, passwords and group names 

When Presenter IS run so that it accesses a key file, the user is 
asked for his/her name before the soOware does anything else. 
If the name entered is in the key file, Presenter offers the user 
the tests he/she is scheduled to do. If another name is typed in, 
Presenter refuses to run. Thus you need to enter all allowable 
user names into the key file . 

User names 
User names can be any string of up to 16 characters (as in the 
rest of Question Mark Designer). You can use people's real 
names, some kind of code or identifying number, or any text 
identification that you want. 
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Passwords 

Group 
names 

Normally you should have a separate user name for each 
person who is running Presenter, but there may be some 
circumstances where you want a common name to be used by 
many people. For example, you could give all managers the 
name "MANAGER" if you don't need to record personal 
identities. (Obviously, you cannot then restrict 1he number of 
times each person can take a test.) 

As well as defining a user name, you can also set a password 
that the user must type in for Presenter to accept the user as 
genuine. This can be any string of up to 8 characters. 

If you need to identify users securely, you should set 
passwords. and make sure that they are hard to guess This 
makes it impractical for someone to pretend to be someone 
else, unless they are given the password. 

If you set Options I Generate Passwords on, then the 
software automatically generates random passwords for you 
when you add users, which can be useful if you have large 
numbers of users. 

You can also assign users to groups. These groups can 
represent classes, regions or any other divisions of users that 
are convenient for you. A group name can be any string of 16 
characters. 

Groups can be used within Guardian for managmg and 
scheduling users, and group names are also stored in tlle answer 
file . 

Letter case (1e whether you use upper or lower case) is not 
significant in user names. passwords or group names 
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Adding a 
user 

~ 

T he Users window 

Users in a key file are shown within Guardian in the Users 
window. The number of users in the key file is shown in the 
window caption, and the name, password and group of each 
user is shown in the scrollable window 

The figure helow shows a window with 6 users, 3 in the 
ROMANS group and 3 in the GREEKS group. Only one user 
has a password set. 

-1 Users (6) , .. , .. 
IUs er Group Password 

ARCHIMEOES GREEKS 
~ 

BRUTUS ROMANS 
JUUUS CAESAR ROMANS 
OVIO ROMANS POETRY 
PUTO GREEKS 
SOCRATES GREEKS 

To be able to add or change user information, you need to 
make this window current You can do this by clicking on any 
part of it, selecting from the Window menu, or pressing 
CTRL-F6. You can then change user information via the User 
menu 

You can choose to view users in alphabetical order of user 
name or by group order. You can set which of these orders you 
want with User l Sort. 

To add a user. you select User I Add, and fill in the dialog 
box. 
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Selecting 
users 

Deleting a 
use r 

- ---------- ---- --
Add user details 

Name: I .QK I 
t t ancel I 

Group: 

H~1p 

Password: 

You must set the user name, and can set a password and group 
name. [f Optio ns I Gene rate Pass words 1s on. then the 
software automatically generates random passwords for you. 

So as to make it easy to add lots of users, afier adding a user, 
when you click on OK, the software automatically takes you to 
a dialog to create the next user, and so on. Clicking on Cance l 
or pressing ESC ends the process. If you define a group name 
for one user. it is carried forward for other users. 

You can select a user by clicking on it in the wmdow. To 
select multiple users, click and drag, or click on each one 
while holding down the CTRL key. User I Select All selects 
all users User I S e lect Group selects all users in a group. 

To delete a user or users, select them and choose Use r 
De le te. 
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Edit ing 
information 
on a user 

To change mformation on a user, double click on it, or else 
select and choose User I Edit. 

To assign multiple users to a group, use User I Ass ign 
Gro up. This prompts for a group name, and sets all users to 
that group. 

2.3.3 Importing a nd exporting lists of users 

User I Expo rt exports all users in the key file into an Ascii 
file. User I Import takes an Ascii file and adds the users in it, 
to the currently open key tile. 

Both importing and exporting use the same format of the Ascii 
file, with one line per user. Each line contains: 

The user name ( 16 characters). Blank if undefined. 

Two blank spaces. 

The password (8 characters). 

Two blank spaces. 

fhe group ( 16 characters). Blank if undefined. 

You can use the exporting facility to print a list of all users, or 
to export the user names to another program. You can use the 
importing facility to copy names from another program, eg a 
word-processor. Imported names are added to those that exist 
already 

The export and import formats are the same, so you can export 
some users. edit them in a word-processor or other program, 
and re- import them, for example to a new key file 
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2.4.1 

If you are using Question Mark Professional for DOS, you can 
export names from Guardian and import them to the DOS 
software, and vice versa, though groups and passwords are not 
compatible between the programs. 

Adding tests into a key file 

How to add a test 

To add a test into a key file, you make the Tests window 
active (eg by clicking on it) and then select Test I Add. 

ln order to make it easy to add several tests to a key file, when 
you have added one test, you are invited to add a second one, 
and so on. Click on Cancel or press ESC to finish adding 
tests. 

On adding a test, you choose interactively a .QDT test file. The 
test file is referenced by the key file , not copied into the key 
file. This means that if you change the test file, the key file is 
not automatically updated with any changes (eg in the test 
name). You should usually only add tests to a key file when 
they are released and ready to run. 

If the test file is protected with a password, you must quote this 
before being able to reference it in the key file. When you have 
done this, you see a dialog asking you to define the details of 
the test entry in the key file . 

The dialog shows the test name (the Question Mark Designer 
internal name), the test filename (the DOS path and file name) 
and the status of the fi le (whether it is locked or unlocked). If 
the test file cannot be found in its original directory, the status 
shows as Not found. 
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Use Path 

Answer file 
directory 

C Ch a nyt lc !. l ckla il > ' 

Test Name Status 

f'Aatha end Finance teat pnloclced 

Test Fllename 0 Use Path 

&:\ODESIGN2\EG1.0DT 

Answer file directory 

...__D_ro_ws_e_ •• _....,l .._( _..;;;;12_•~-e _& li...,.l_me_ .. _. __.I I 
ten eel Uelp 

The other fields in the dialog work as follows. 

If you set this on, then Presenter will look for the test on the 
original path (ie the same drive and directory as in the dialog). 
This means that when the user takes the test. his/her path to the 
test must be the same as yours. 

If you set this off, then Presenter will look for the test file in 
the current directory. or in the directory defined in the /Q 
parameter to Presenter. 

On a network, you would usually set Use Path on, because the 
path for the user/student will normally be the same as the path 
(on the server) when you are setting it up. However if you are 
distributing a key t1le on floppy disk for use at another site, 
then the path rhe test file will be in may be different on the 
deftvery machine, and you will want to set Use Path off 

This is the directory that answer fi les from the test are written 
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Date & Time 

to. lt defaults to whatever you set the introduction dialog 
answer file directory to be, but whatever you set in this dialog 
is the one actually used for this test. You can use the Browse 
button to interactively select a directory. 

When an answer file is saved from this test via the key file, this 
is the directory it is saved in. If you om it the drive letter, the 
current drive is used. 

You can leave thls box completely blank, which means that the 
answer file will be saved on the Presenter working directory. 

(An answer file is only saved if the control information page of 
a test has Save answers to disk set on. The key file does 
not change whether answer files are saved: it just defines in 
which directory they are saved.) 

If you press the Date & Time button, you get an additional 
d1alog which allows you to restrict access to the test from or 
until particular times and dates. 

In the example dialog below, access to the test is permitted 
from 9am on the I st September 1995 to Spm on the 30th 
September I 995. 

You set a start date and time for a test by setting Allow 
access from , and you set a closing date and time for a test by 
setting Allow access until. For each test, you can set neither, 
one or both of these. This faci li ty relies on the correct date 
being set on the PC, and is vulnerable to a user setting the date 
or time deliberately incorrectly by accessing the Control Panel 
or DOS or otherwise. 

lO 

Network Guardian Making a key file 

Atte mpts 

= flr•.lru:l 111 f t'!•'• hy huu· lUUJ d rth : 

181 Allow accen from 1811AIIow liCCUI untiiJ 

From Until 

L:JIAI [!] 
Minute ~~ Minute 

CJ~ !lour ffe]~ Hour 

~[!) 
00 

Day ~(il 
(!J 

Day 

LJ~ Month LJ(tJ Month 

~~ Year ~~ Year 

I .QK I I ' an eel I I tteJp I 

Pressing the Attempts button gives you access to an 
additional dialog that allows you to control how often the test 
is offered to each user. This dialog is only available if Write 
results to key file is set on in the mtroduction dialog, 
because 1f results are not wntten to the key file. then the 
number of previous attempts is not known. 

Here you can set the Priority of a test, whtch IS a 
number from 0 to I 0 that lets you set a sequencmg order 
of tests to be done. Presenter otTers all available tests of 
priority I 0 first, then priority 9 and so on down to priority 
0. The defaull priority for a test is 0 (lowest priority). 
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For example, you might set a basic and an advanced test, 
with users only allowed to take the advanced test when 
scoring at least 80% in the basic test. You could give the 
basic test priority I and allow it to be at1empted until an 
80% score was achieved. If you then give the advanced 
test a priority of 0, the advanced test would not be 
available until the basic test had been passed. 

Cuntrolprwrity IIIHllltto·rrtltf•, 

~ !AI 
'oo 

Priority 

181 Umlt number of attempts 

Attemptt 

®~em(!t number of timet) 

11 
[!) 
'oo 

Attempts 

0 Attempt until passed 

tencel 

Setting the Limit number of attempts check box lets 
you restrict the number of times a test is done. There are 
two alternative ways of limiting the number of attempts • 
you can either choose to set a fixed number of attempts 
the user can do, or else allow him/her to continue to do a 
test unti l a pass mark is reached. If you do not set this 
box, the test can be done an unlimited number of times 
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when scheduled. 

If you select Attempt number of t imes, then you can 
set the number of attempts allowed. Once this number of 
at1empts has been made, the test is no longer available. 
For example if you set one at1empt only to be made, then 
a user can do the test once, and then it will no longer be 
available. 

If you select Attempt until passed, you define a 
percentage score that must be achieved, and the test is 
continually available to the user until he/she attains this 
pass mark . Once the user scores this or higher, the test is 
no longer available. 

You can include the same test fi le several times in a key file, 
with different information in it. For example if you want to 
give a test to one class one week and another class the 
following week, you could add it twice to the key file for the 
different date ranges. The test would be in the key file twice. 
one reference scheduled to one class, and one to the other. 

The Tests window 

The Tests window shows how many tests are currently defined. 

You can manage tests with the Test menu similarly to the 
Use r menu. Test I Dele te removes a test, and Test I Edit or 
double-clicking allows you to change details. Test I Select 
All selects all tests. 

The following information is displayed in the test window for 
each test. (You may need to maximise or scroll the window to 
see all the information.) 
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The test name (within Question Mark). 

The current locking status (locked or unlocked). 

The dates between which the test is valid, as appl icable. 

The test priority, the way attempts are restricted, and the 
pass percentage if applicable. 

Whether Use Path is set. 

The DOS path and file name of the test. The path ts only 
used by Presenter if Use Path is set. 

Locking and unlocking tests 

Usually test files can be run with or without a key file . Anyone 
with access to Presenter can run these tests without any security 
control. 

Using Guardian, you can lock tests. This means that no-one can 
access them with Presenter except through a key file created 
with Guardian. Locked files can also not be opened with 
Designer. which can prevent the test being changed after it has 
been scheduled. The only way a locked test can be accessed is 
via a key file. (Note that only test files can be locked; library 
files cannot be locked.) 

To lock a test, you use Test I Lock. If a test is 
password protected within Designer, you need to quote 
the password to lock it 

To unlock a test, you use Test I Unlock. 

The current status (locked or unlocked) is shown in the Tests 
window. 
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All tests that you want to be secure, ie that can only be run via 
a key file, should be locked. Remember that once you lock a 
file. you need to use Guardian to unlock it if you want to 
access the test file with Designer (or with Presenter without 
using a key file). 

If two users of Guardian both lock a file, and if one of thern 
unlocks it, then it becomes unlocked, even if one of the users 
wouJd prefer otherwise - this is a pitfall to beware of if there 
are multiple users of Guardian. 

2.5 Scheduling users to tests 

2.5.1 Basic procedure 

Once you have entered users and tests into the key tile, you 
need to schedule which users can take which tests. 

If you want to discover what scheduling is currently in effect, 
select all users and all tests, and then choose User I Results 
or Test I Results. This lists all scheduling for the selected 
users and tests. See Chapter 4 for a full description of these 
reports. 

To schedule users to tests, you do the following. 

I . Select one or more users. You may find the User I 
Select group or User I Select All commands helpful. 

2. Select one or more tests, 

3. Choose Schedule I Schedule. This makes an entry in 
the key file saying that the selected users are scheduled 
to do the selected tests, and gives you an information 
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message saying that the scheduling has been done. 

Sche duling comple ted 

3 tests scheduled to 7 users 

If you want to remove scheduling, you can do so with the 
same procedure but selecting Schedule I Unschedule. If in 
doubt as to whether scheduling is in effect, you can just select 
users and tests and unschedule them to make sure. 

When a user is schedu led to a test, this information remains in 
the key file until he/she becomes unscheduled. (Even if the 
conditions for the test to run no longer apply, eg the date has 
passed or the number of attempts have been used up, the user is 
still considered scheduled to do the test, and this information 
will show in the reports.) 

Scheduling duplicates 

You can schedule the same user to do the same test more than 
once if you want. Each instance will appear as a separate entry 
on the test menu for the user to do (even though it will be the 
same test file) 

If Options I Check w hen scheduling 1s set on, then the 
software checks to see if the user is already scheduled to take 
the test, and asks you interactively for each occasion of 
duplication what you want to do with the durlication. 

• You can choose Keep old and add new. which means 
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that both schedulings remain in effect. Thus the user will 
be scheduled to do the test more than once. 

You can choose Cancel old and add new, which 
means delete the old scheduling and add in the new one. 
This means that the previous scheduling is cancelled, and 
replaced with the new scheduling. 

You can choose Keep old and cancel new, which 
means do not change the current scheduling. 

(If Options I Check when scheduling is off. this has the 
same effect as choosing Keep old and add new. ie the new 
schedulings are added to the old ones.) 
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3. 

3.1 

3.1.1 

How Presenter works with 
a key file 

CaUing Presenter 

Telling Presenter which key file to use 

You must use version 2. I 0 or higher of Presenter with 
Guardian. Earlier versions of Presenter do not look at key files. 
There are two ways you can tell Presenter whjch key file to 
use. 

I. The best way 1s to pass the name of the key file on the 
command line using the /C• parameter. 

For example: "PRESENT.EXE /C=D:\QM\KEY.QDK" 
uses the key file KEY.QDK in D:\QM. 

2. If you do not pass the name of a key file . Presenter looks 
on its working directory and see if there is a key file 
there. If so, it uses it. 

lf there is more than one key file on the working 
directory, Presenter chooses the fi rst one in DOS order 
(the one that appears first on a standard DOS directory 
listing). If you are using this method of accessing the key 
fi le, you are safest by making sure that there is only one 
key file in the directory. 

If Presenter is not passed a key file with the /C=­
paramcter and cannot find a key file m its working 
directory, it runs nonnally offering the user a choice of all 
tests in the directory. 
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3.1.2 

You need to be careful about where you put key fi les. Because 
Presenter picks one up if 1t is there (as m 2. above). then a key 
file can disrupt an ord inary attempt to use Presenter without 
Guardian. You may wish to keep all key files in a special 
directory to avoid this happening. 

As with all Windows programs, you can set the working 
directory for Presenter from Program Manager, by selecting its 
icon, and then using File I Pro pe rties (or pressing 
ALT+ENTER) to edit the Wo rk ing Directory box. You can 
also edit the command line in the same way, perhaps to add a 
IC= parameter for every time Presenter runs, setting the 
Command Line box 

C hanges in the way Presenter is called 

When Presenter is operating with a key file, it is no longer 
possible to spec1fy the test to be run and other information from 
the command line. Instead you put the key file on the command 
line with the /C= parameter. and specify the infonnation about 
tests in the key file. 

The lP= parameter which defines in which path the 
answer file is stored is ignored. The answer file is always 
stored in the directory referenced in the key file when you 
define the test 

The ID parameter which allows the user to choose tests 
from different directories IS ignored 

The IQ= parameter. which can define the path that test 
files reside in, is only used for any tests that do not have 
the Use Path field set (see section 2.4. I). If the Use 
Path field is set, the path for the test file is taken from 
the key file. 
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The IS= parameter which can define the user name is 
allowed, but the name is checked agai nst the list of names 
in the key file. lf the name is in the key file, the software 
behaves as if the user had typed in the name. If the name 
is not in the key fil e, the software asks the user for a 
name, ignoring the IS= parameter. 

The standard IH and /K parameters continue to work. 

3.2 Running a test 

When Presenter is run via a key file, the following sequence of 
actions happens. 

t. The user is prompted for a name. If the name is not in the 
key file, the user is gjven an error message, and re-asked 
for the name. This is permitted to happen up to three 
times before the software exits. (The name can also be set 
with the /S= parameter.) 

2 If the key file has a password set for the name, the 
password is asked for. Up to three tries are perm1tted to 
enter the password, and if it is not entered correctly, the 
software exits. 

3. A window is then presented to the user containing a list 
of all tests available to the use r, with Run and Exit 
buttons, similar to the standard Presenter window for 
choosing which test to run 

The user name is shown on the dialog above the list of 
tests, and the introduction message defined in the key fil e 
(see section 2.2.3) IS shown below it. In the example 
below, there are 4 tests available. 
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Employee 135041 

BusincG~> test 
Examples of each question type 
Maths and A nance test 
Quotations test - who said what ? 

.Bun fxJt 

Do the above tests In any order you want. 

You can put an Introduction message of up to four linea 
of text here say ing whatever you wanl 

Co I ht c Question Mark Com utln Ud. 1993 - 1995 

Tests are shown on the list if they are scheduled in the 
key file , and the appropriate conditions (eg time and date 
range) are met. If available tests have different priorities. 
then only these tests at the highest level of priority are 
shown, and any others are only shown when the higher 
priority ones are done and become no longer available. 

If a test referenced in a key file cannot be found, it is 
ignored, and omitted from the list. The file is looked for 
either on the path set on the key file , or else if Use Path 
is not set then on the /Q= path if there is one defined, and 
otherwise on the current working directory. 

When looking for tests, Presenter looks for the test by its 
DOS fil e name as stored in the key tile. not by the 
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5. 

How Presenter works with a key file 

Question Mark name set in Designer. But in the user 
dialog, tests are described by their full descnptive test 
name. 

The user then does the test in exactly the same way as if 
there was no key tile. Any multimedia calls or external 
tests are executed in the standard way, with no special 
security controls from the original key file . If you plan to 
re-call Presenter from within a test. and you wish to use a 
key file, you should use a different key file from the one 
being used to run the first test, or call Presenter so that 
there is no key file in the working directory. 

The answer file is saved in the directory specified in the 
key file. 

6. (Unless Write results to key file is set ofl) Presenter 
updates the key file to show that the test has been 
attempted by the user, and records the score achieved m 
the key file. 

If Presenter is unable to access the key fi le, it tries a 
number of times and then gives a message to the user 
saying that it is unable to access the key file and asks the 
user to contact a supervisor. Retry and Cancel buttons 
are offered at this stage - Retry retrying the key file 
access, and Cancel ignonng it. Usually the reason for a 
fajlure to access the key tile is because someone else is 
accessing it, eg someone is in Guardian amending 11, and 
this can be rectified by them leaving, and the access 
retried. 

7 Presenter then shows the user another list of tests. This 
may be d1fferent to the previous list • for example the test 
Just run could be removed from the list if the user has 
passed or done all his/her attempts, or else new tests 
could be added if the test just run had a bjgh priority set, 
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and is now done 

This process repeats indefinitely until the user exits. 

Please note that if a key file is being used, only those tests 
scheduled m the key file for the current user are shown as 
available in Presenter Other tests, whether locked or not, are 
not shown on the list If there is just one test available, 
Presenter does not automatically run it (as happens without a 
key file) · the test is simply shown on a list of one. 

lt can happen that no tests are available. either because none 
are scheduled, because they are all done. or because they cannot 
be found. In this case. the user gets a list of zero tests, and 
must press Exit to continue. 
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4. 

4.1 

4.2 

Reviewing results after 
using Guardian 

General concepts 

There are two ways that answers can be recorded after a test is 
delivered via a key file. 

I. The answer file is stored in Lhe usual way. 

The key fi le defines the d1rectory in which the answer file 
is stored. If you wish, you can choose to store answer 
files from different tests 10 different directories, for 
example to make it easier to analyse them separately. 

2. Information is also stored in the key file (unless you have 
turned off Write results to key file when making the 
key file). 

You can use Guardian to report on this information, as 
described in the rest of this Chapter. 

Guardian report disJ>lay options 

There are several reports available within Guardian. These all 
create an Ascii text file containing the data, which you can look 
at on-screen, print, or import into another program. The way the 
reports are viewed works similarly to Reporter. Ily defaul t the 
information is saved to a text file called INFO.TXT and viewed 
with Notepad. 
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4.3 

You can change the way reports work from the Options menu. 

• Options I Editor allows you to set a different program 
to Notepad to view reports in. 

Options I Report name lets you set the path and file 
name for the report file . 

Options I Append to report allows you to append 
information from several reports after one another, rather 
than let each report overwrite the previous one. 

Options I View report automatically allows you to 
set whether you want to view reports automatically as 
soon as they are made. 

See the main Question Mark Designer for Windows manual for 
f~ll~r information about the way reports work. They work in a 
S1m1lar way 1n Guardian as in Reporter. 

The reports available from Guardian 

To get a report 10 Guardian, you select one or more users or 
one or more tests and select the Information or Results 
options from the User or Test menus. 

Us~r I Information or Test I Information simply include 
the Information visible on the screen in Guardian, ie they list 
the users or the tests, with all the information set in Guardian. 

User I Results or Test I Results provide more information. 
For each user and test selected, these reports show information 
on scheduling and results 
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User I 
Information 

Test I 
Information 

User I 
Results 

Th1s report shows the user name. password and group for the 
selected users. (For all users, select all of them.) The data in 
the report is the same as when exporting user information An 
example report might be: 

Andrew Brown 
Bob Joaephll 
John Smith 
Peter Jones 
Amllnda Simpson 
David Willlom.s 
Robert Ad&J113on 
Sue Jameson 

TYPOIE 
OTY1JEU 
TREREQ 
YTREUU 

CLASS A 
CLASS A 
CLASS A 
CLASS A 
CLASS B 
CLASS B 
CLASS B 
CLASS B 

(The users in Class B have passwords set. and the users in 
Class A do no1.) 

This report shows the information defined in the key file for 
the selected tests (For all tests, select all of them.) An example 
report might be: 

Tes t Filename: C:\QDEStGN\EG1,QDT 
Test Name: Maths and Finance teat 
Use Path: No Status: Unlocked Pc1ocity: 0 
From: None Unti 1: None 
Attempts: Unlimited 

Test Filename: C:\QDESIGN\EG2.QDT 
Test Name: Quot~tion~ test - who said what ? 
Use Path: No Status: Unlocked Priority: 0 
From: 09:JO 1/09/1995 Until: 11:59 30/09/1995 
Attempts: Unlimited 

Test Filename: C:\QDESIGN\EG3.QDT 
Test Name : Examples o! ooch question type 
Use Path: No Status: Locked Prior1ty: 1 
From: None Until ; None 
1'-ttemptll: 1 

This report shows a list of results and schedulings of users and 
tests. It applies to those users and tests that are selected; ie to 
get the report, you must first select one or more users and one 
or more tests. 

46 

Network Guardian Reviewing results after using Guardian 

Test I 
Results 

To get a complete list of all schedul ings and results, select all 
users and all tests, and call for the report. 

If Class A in the example above had been scheduled to two 
tests, then an example report (before any tests had been run) 
might be the following. 

Andcew Brown CLASS A 
Test Narne Date Attempt Score I 
MA ths and Finance te~l 20/09/1995 Scheduled 
Quota tion~ test - who sald whot7 20/09/1995 Scheduled 

Bob Jo.sephs CLASS A 
Test Name Date Atte111Pt Score \ 
Maths and Finance t~st 20/09/1995 Scheduled 
Quo~at1ons test - whn said what? 20/09/1995 Scheduled 

John Smilh CLASS A 
Test N&me Date Attempt Score li 
Maths and Finance test 20/09/1995 Scheduled 
Quotations test - who ~aid what~ 20/09/1995 Scheduled 

Peter Jonu CLASS A 
Test Name Date Attempt. Score ~ 
Maths and Finance test 20/09/1995 Scheduled 
Quotations test - who said what? 20/09/1995 Scheduled 

Note that a user remains schedu led to do a test until 
unscheduled. The report will show the fact that the user has 
been scheduled, even when the test has been taken 

Every time a user runs a test from a key file, the results are 
stored in the key file, even if the test is not fin ished (eg there is 
an error or the time runs out) 

·rhis report is s1milar to that from User I Results , except that 
it is ordered by test rather than by user. Again, you must select 
the users and tests you are interested in. before call ing for the 
report. 

Suppose that each person in the example above does the Maths 
and Finance test once, then an example report for that test 
might be. 
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Maths and ~inence test 

User 
Andrew Brown 
Bob Josephs 
John Smith 
Peter Jones 
Bob Josephs 
Bob Jouphs 
Andrew Brown 
John Smith 
Peter Jones 

Group 
CLASS A 
CLASS A 
CLASS A 
CLASS A 
CLASS A 
CLASS A 
CLASS A 
CLASS A 
CLASS A 

Reviewing results after using Guardian 

Date 
20/09/199!> 
20/09/199~ 
20{09/199!1 
20/09/199!1 
2 1/09/1995 
21/09/199~ 
21/09/1995 
2 l/09/199S 
2 1/09/1995 

Attempt Score ~ 
Scheduled unlimited times 
Scheduled unlimited times 
Scheduled unlimited times 
Scheduled unlimited t1mes 

1 lS 
2 63 
1 20 
1 5S 
1 as 

From this report, we can see that user Bob Josephs has taken 
the test twice, the first time with a low score and the second 
time with a higher score (This test was scheduled an unlimited 
number of times, so multiple attempts are possible, but each 
attempt is recorded.) 

Network Guardian Examples of use of Guardian 

Appendix A 
of Guardian 

Examples of use 

A.l Test delivery on a standalone PC 

This Appendix gives some examples and ideas on how to use 
Guardian. Guardian is a very flexible program, and there is a 
lot more you can do than is covered here, but these ideas will 
cover some common uses. 

One of the simplest uses of Guardian is to control access to 
tests on a standalone or notebook PC. One way of domg this is 
as follows. 

Make sure Presenter is on the PC. for example in 
directory \QDESIGN. (Check that you are licensed to use 
Presenter on this PC; you need an extra licence to use 
Presenter ofT the site in which Designer as used.) 

2. Put the tests you want to run in a directory, for example 
\QDESIGN. 

3. Create a key file with the possible user names, the tests 
and the scheduling you want. You may wish to lock the 
tests. Store the key file in directory \QDESIGN. 

4. Create an icon in Program Manager to call Presenter. Set 
\QDESIGN\PRESENT.EXE as the command line and 
\QDESJGN as the workmg darectory. 

When users run Presenter, the key file will then be accessed, 
and the tests available offered. (You shou ld make sure that 
there is just one key file in directory \QDESIGN) 
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A.2 

Tests 

Users 

Test delivery on a network 

Here are some suggestions for senmg up Question Mark and 
Guardian for use on a network , 

You may want to make separate directories for tests that have 
been released for use, and tests that are still in development. 
Released test and library files should be stored in a public 
directory; tests under development should be stored in a private 
directory. 

You can make the public directory read-only, or else set each 
file in it as read-only. However before doing this (perhaps 
before copying them to this directory as you need write access 
to do the locking), you should usually lock all test files with 
Guardian. This prevents access to the files by Presenter except 
via a key file . 

(If you want to lock a test file without necessarily including it 
in a permanent key file, you can do so by making a new key 
file, including the test in it, locking it, and then exiting 
Guardian without saving the key file This locks the test file, 
with no other effect.) 

You should allocate each user who is able to take tests a 
unique 16 character name. 1 f your network makes users logon 
with a name, you may be able to use this name within 
Question Mark. (If so. you can pass the name to Presenter 
using the /S= parameter.) 

You may want to allocate a password for users to deter 
impersonation. You can think up these yourself, or else the 
computer can generate them for you at random. To do this 
when adding users. set Options I Generate passwords on 
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Groups 

The key file 

in Guardian. 

If you have many users. you may want to export or report on 
user names and passwords from Guardian, to be able to 
communicate to each user h1slher name and password You can 
either make a printout and cut up the paper with the names and 
passwords on to give to users, or you can use a word-processor 
to mail-merge the mformation into a letter or memo to users 

You are recommended to diVIde users by groups, especially 1f 
you have many users. In ed ucation, you may wish to use 
groups to represent different classes or years of students; in 
busmess, you may want to use groups to represent different 
categories of employees, eg d1fferent branches 

Even 1f there is no distincti on between your current users. it can 
be worthwhile to allocate them all to a single group name. This 
means that if you later have a different category of users. you 
can call them u different group, and this will then help you 
review the answer files or results in the key file by category of 
users. 

You should put all users and reference all tests in the key file. 
Tests should be added by reference to the release directory (not 
the development directory), with Use Path set on 

You can then schedule users to tests. You may want to set 
date/time lim1ts on tests to prevent users from accessmg tests 
before or after they are allowed to. You may also want to set tn 
the key lile where answer fi les are stored, perhaps in different 
directories for different kinds of tests, or in a central network 
answer file directory. 

You should consider making a public directory to store your 
key file 10. Unless you set Write results to key file off, users 
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will need write access to the key file. If you or your network 
administrator do not like this, you can choose not to write 
results to the key file, providing you don't need to limit the 
number of attempts each user has at a test, 

You should tell Presenter which key file to use by using the 
IC= parameter to point at the file when defining the call to 
Presenter - either in the Windows icon command line invoked 
by users, or in the network menu system entry that calls 
Presenter. 

A.3 Control of tests run at a distance 

Setting up 
the files to 
send 

Guardian can also be used to control testing at a distance, when 
you want to send a user Presenter, test files and a key file , and 
control how the tests are delivered. 

You need to send the fo llowing files: 

Presenter (file PRESENT.EXE). You need a Question 
Mark distribution licence that gives you permission to 
copy Presenter in this way. 

The test files that are being delivered (and any subsidiary 
library or multimedia fi les). You should usually lock U1e 
test files . 

The key file to control access to the tests. You should 
make sure that Use Path is set off for all tests, as you 
may not know what directory the user will use. 

lt should be safe to put all the user names in the same key file , 
though you can make separate key files for each user if you 
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Sending the 
flies 

How the 
user runs 
the teat 

prefer. You could alternatively have one generic name that you 
tell people to enter (eg DEMO or STUDENT), so that everyone 
uses the same name. If using a generic name, you might want 
to change the standard logon message "Enter your name·" into 
something like "Type DEMO to identify yourself'. to remind 
the user of the name he/she is supposed to enter. 

One way of sending the files is to copy them onto floppy disk, 
and to post the floppy disk. 

Alternatively. you may be able to send the files electronically, 
by e-mail or in some other way. If you are sending them 
electronically, you may want to compress the files to make the 
send easier and less expensive. 

If you are using a floppy disk, the user could run the test(s) 
directly from the floppy disk. In this case, you would tell the 
user to put the disk in the drive, and then run file 
PRESENT.EXE from Program Manager or File Manager. 
However running from floppy disk is very slow, and is likely 
to be impractical in most cases. 

Usually, you will want to get the user to load the files onto 
his/her hard disk, and you should provide instructions for doing 
this. The instructions need to cover the fo llowing steps. 

I . Make or find a suitable directory to be used to store the 
files on. If an existing directory is used, it wou ld be 
sensible to delete any existing files on the directory 
before loading the new files (or at least delete any key 
files) . 

2. Copy all the files onto this directory. (If the files are 
compressed. then obviously they must be uncompressed 
first.) 
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Returning 
answers 

A4 

3. Provided that there is no other key file on the directory, 
the user can be told to run PRESENT.EXE from Program 
Manager or File Manager. 

You may be able to automate this process with an installation 
program or batch file, or even with a self-extracting 
compression method. 

If you are distributing tests on floppy disk. you can set the path 
for answer files to be stored within the key file for each test as 
A:\ (assuming the user's floppy drive is A:). This will store the 
answer file on the disk, which can then be mailed back to you. 
You should obviously leave enough free space on the disk for 
the answer file(s). {Try out the tests first, to see how large the 
answer fi les are likely to be if all questions are answered.) 

If distributing tests by e-mail. you should get the user to e-mail 
you back the answer file. In this case, you should probably 
leave the answer file directory in the key file for each test as 
blank, so that the file is saved in the current directory. 

You may also want the user to delete the test and other files 
from the bard disk after delivering the test 

Creating a sequenced set of tests 

You can combine the faci lities for setting priorities and running 
a t.est until a pass mark is achieved to create a group of tests 
that are done in combination. 

For example, supposing you have 4 tests A, B, C and D, and 
you want the user to be unable to run test C before getting 80% 
on A and B, and also be unable to run test D before getting 
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A.S 

80% in A, B and C. 

Then you could set tests A and 8 as priority 2, test C as 
priority 1 and test D as priority 0. You would set tests A. B and 
C to be attempted until a pass mark of 80% was achieved. 

Presenter would then initially otTer only tests A and B (as they 
are higher priority than tests C and D). The user could choose 
to run either test A or test B. and each would be removed from 
the list of tests when a score of 80% is achieved. When both 
are removed, Presenter looks at the next priority level and 
would otTer test C. Then when a score of 80% in this is 
achieved, Presenter would look at the last priority level and run 
test D. 

You could tell the user that this was happening by setting 
appropriate messages in the final pages of the tests, depending 
on whether the user got more or less than 80%. You could also 
define some introduction wording in the key tile, which would 
appear in the Presenter dialog showing the list of tests 

Use of multiple key files 

There are many circumstances where you may want to make 
multiple key files, including the following. 

If you have more than one person using Guardian to set 
up key files, you may decide to have a different key file 
for each user of Guardian to avoid confusion. (Please see 
the licence conditions at the front of this manual for how 
you are licensed to use Guardian; if you use the software 
on more than one PC, you need to purchase a site licence 
for Guardian or additional copies) 



Network Guardian 
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If you have more than I 000 users or more than 60 tests, 
then you need to create multiple key files as these are the 
maximum that can fit in one key file. 

If you are calling Presenter from itself (as an external test 
or multimedia call) to do nested testing, you will need to 
use a separate key file for each nested level of Presenter 
(If you do this, then if you are using passwords, each 
level of Presenter will ask again for the user's password.) 

If you are using Question Mark in a number of separate 
applications or areas, you may decide to have a separate 
key fi le for each, to aid organisation of your work. 

Because a key file can record results to tests, you may 
wish to freeze or archive a key file at some point, for 
example the end of a training class or tenn, and start a 
new key file for subsequent use. 

Remember that if you do make more than one key file, then 
you must identify to Presenter which one it should use. The 
safest way to do this is by using the /Ca parameter to point at 
the file. For example, you could have a series of icons in 
Program Manager each calling Presenter with a different 
command line pointing to a different key file. 

You can make a new key file from an old one by opening it 
and then saving it as a new fi le. This is often the best way of 
copying infonnation from an existing key file to a new one. 
You can also copy users from one key file to another with the 
import/export facility. 
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Appendix B Notes on security 
• Issues 

No computer system can be completely secure. Guardian 
improves the security of standard Presenter and also allows you 
to schedu le tests in a powerful way, but it is not a complete 
solution to everyone's security problems. 

Please, please remember to make back-up copies of all your 
important fi les, including key files, test files and answer files. Jf 
there is a hardware or software malfunction, or if you make a 
mistake, you could lose your important data. Many more people 
will run into problems arising from fai lure to make a good 
back-up than will run into problems associated with not having 
good enough security. 

However here are some guidelines to consider. which will 
tmprove securi ty in most environments. Don't worry if you 
cannot follow all these guidelines. In most organisations, it is 
unlikely that any student or trainee will seriously try and break 
into computerised testing. 

I. Make sure all test files are password protected with 
passwords others will not guess. If this is done, no-one 
will be able to look at the files in Designer, nor reference 
the files in Guardian, without quoting the passwords. 

2 Make sure that you set a name and password for your key 
file that others will not guess. If someone can use 
Guardian to get into your key file, this removes all the 
security provided by Guardian. 

3. If you do not want people to be able to run your tests 
without using a key file, lock them This will prevent 
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4. 

5. 

6. 

Notes on security issues 

access to them with the standard Designer or Presenter. 

Do not a llow users access to the Guardian program. Even 
if they do get access to Guardian, it is not that easy for 
them to do something with it, but there are some possible 
loopholes. Preventing people from running Guardian and 
from seeing this user manual are sensible precautions. 

Choose good passwords for users and foster an 
atmosphere where people will not tell each other their 
passwords. The user name and password are the main 
protection you have that people are who they say they 
are. 

Make sure the Allow question window to be re­
sized or moved box is turned off in the control 
information for tests within Designer. If this is on, users 
are allowed to switch to other programs while taking a 
test, which can be a security hazard. 

7. Consider setting up user PCs so that it is not possible for 
users to access files and programs they don't need to. 

If running on a Novell or similar network, use the 
facilities available to restrict access to directories, to 
prevent users from directories except those needed. 

If users have access to Program Manager, consider 
amending the PROGMAN.INI file to remove users' 
abilities to make new icons, run programs or exit 
Windows. Also remove access to File Manager and 
the DOS command line prompt, which allow users 
to delete and copy files. 

Try and prevent users from having access to a local 
floppy disk drive, that they can copy files to. 
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8. 

Notes on security issues 

Consider what happens when a user turns off the 
PC, and the computer re-boots. It may be possible 
for a user to enter DOS in this way, and so access 
other files and programs that you would not want 
him/her to. PCs can be set up to prevent this being 
possible. 

For maximum security, you should invigilate tests. This 
will make it harder for people to impersonate each other 
by swapping passwords, and can also deal with most 
other security problems. The user name is displayed on 
the Presenter dialog showing the list of tests, and can be 
displayed on the status line while answering a test; 
checking these can protect against impersonation. 

If a user has access to an unsupervised PC, then if they 
are sufficiently clever and have enough time, it is 
theoretically possible that they could get through almost 
any security. But if they are properly supervised, then 
security is much stronger. 

If users have free access to File Manager or DOS, for example 
if you are sending tests at a distance by floppy disk, and you 
cannot prevent them from using their PC as they please, then 
there are several loopholes in the Guardian security. Some 
examples of these, so you can be aware of them are: 

The key file records all attempts at tests. However a user 
could make a copy of a key file before running a test, 
take the test, and then if he/she didn't like the score, 
replace the new key file with the original one, by copying 
it in DOS or File Manager. The answer file would still be 
there, but this could be deleted too. 

If a file is password protected and locked, a user cannot 
access it. However if they have access to Guardian and 
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Designer, they could make another test file with the same 
name, make a key file and lock it, then switch files, and 
unlock the original file. One partial protection for this 
might be to put unusual characters in the test name to 
make it harder to re-enter. 

The protection regarding priorities can be sidelined by 
deleting the file that has to be done first. and the software 
will then switch to the next tiles. 

The protections regarding dates can be sidelined by 
changing the system date via Windows or DOS. 
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Appendix C Trouble-shooting 
and possible errors 
C.l Problems using the Guardian software 

Cannot 
access key 
file (name/ 
password 
forgotten) 

Cannot 
access 
locked test 
file with 
Designer 

Cannot find 
key file 

Cannot run 
Guardian 

You must enter the name and password specified for the key 
tile every time you open the file. If you cannot remember what 
these are, you cannot open the fi le. 

(If you do forget your password, we may be able to help you 
recover your data if you send the file to us.) 

When a file is locked, you are not supposed to be able to 
access it with Designer or Presenter. To be able to edit or look 
at it in Designer. you need to unlock it in Guardian first. 

When you save a key tile, you specify t11e directory in which it 
IS saved. This defaults to the last directory used in Guardian, 
which is stored in the QD_GUARDJNI file. You can check the 
directory by looking at the File I Open dialog in Guardian or 
by looking at the 1Nl tile. 

If you delete the QD_GUARD.INI file in the \WINDOWS 
directory. this restores all Guardian settings to the default ones. 

Check that the Program Manager icon is set up to run 
GUARDIAN.EXE, and that the file exists on your computer. Tf 
in doubt, re-copy the program file from the distribution disk 
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Duplicate 
scheduling 
messages 
are 
confusing 

Need to 
rename or 
delete key 
file 

Not sure 
who Is 
scheduled to 
do what 

Guardian needs the Question Mark .DLL files to be present in 
its directory or in the \WINDOWS\SYSTEM directory to run. 
Check that these are present, and if necessary copy them from 
the Question Mark directory, or from the Question Mark 
Designer for Windows distribution disks. 

If you still have trouble. try deleting QD_GUARD.INT from the 
\WINDOWS directory. 

If Options I Check when scheduling is on, then if you 
try and schedule the same user to the same test a second time, 
you are advised of th is and asked to decide what to do. If there 
are many duplicates, you can get a series of dialog boxes 
asking you what to do. 

To avoid these dialogs. either turn the option off, or else 
unschedule users to remove any out-of-date scheduling, before 
re-scheduling them. 

You cannot rename or delete a key file from within the 
Guardian software. You should use Windows File Manager. 

If you need to know who is scheduled to do what. select all 
users and all tests (or all those you are interested in), and then 
choose User I Results or Test I Results. 

If you want to be sure that nobody is scheduled to do any test, 
select all users and tests and choose Schedule I 
Unschedule. 

If a user is scheduled to do a test. the fact that they are so 
scheduled will always appear on the Results reports until they 
are unscheduled, or until the user or test is deleted. (Even if the 
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Schedule 
menu is not 
highlighted 

Test file not 
found by 
Guardian 

Test menu is 
not 
highlighted 

User menu 
Is not 
highlighted 

What are 
.QJK files ? 

test is only scheduled to be done a limited number of times. 
and that number of times is done, the record that they were 
scheduled remains.) 

This menu is only highlighted when you have an open key file, 
with at least one user selected and at least one test selected 

Guardian will show Not found as the status for a test 10 a key 
file if the test file cannot be found on your PC in its original 
directory. 

This may not maner if there is a different configuration of files 
on the delivery PC. The test will still be found by Presenter if' 
a file of the correct name IS present in a suitable directory 
according to the rules followed by Presenter as set out in 
Chapter 3. 

To highlight the Test menu, you must open a key file, and 
make the Tests window current To do this, click on 11, or 
se lect it from the Window menu. 

To highlight the User menu, you must open a key file , and 
make the Users window current. To do this. click on it, or 
select it from the Window menu 

QIK files are backup cop1es of QDK key files. When you 
save a new copy of a key file with Guardian, the old file is 
renamed with a .Q!K extension. You can disable the creation 
of these files by setting Options I Backup off. 

To recover a .Q!K fi le. you rename it to a .QDK tile using 
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Windows File Manager. 

C.2 Problems using Presenter with key files 

Key file 
preventing 
standard 
use of 
Presenter 

No key file 
f ound by 
Presenter 

The most common problem occurring with Presenter is whether 
a key file is found or not Remember that if Presenter does not 
start by asking you for a user name, then tt has not found a key 
file. 

If there is a .QDK key file on the Presenter worki ng directory, 
Presenter wi ll read this and run tests from it, possibly ignoring 
other command line parameters and test fi les on the directory. 

If you want to use Presenter without a key file , you must move 
the key file to another directory, or set the Presenter working 
directory differently You may want to have a spectal dtrectory 
for key files to avoid this problem, and reference key tiles with 
Presenter using the /C= command ltne parameter. 

If you have specified the key file with the /Ca parameter, 
check that the key file is present in the correct directory 
speci fied. 

If you expect to pick up the key file frorn the working . 
directory, check that it is there and that the Presenter workmg 
directory ts what you expect (check the icon properties box in 
Program Manager). 

Check also that you are using Version 2. I 0 or higher of 
Presenter. Previous versions of Presenter do not work with key 
files. 
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Test does 
not appear 
on the list of 
tests 

User name 
not accepted 
by Presenter 

Wrong key 
file found by 
Presenter 

If a test does not appear in Presenter when you expect it to, 
here are a number of possible reasons. 

Has the correct key file been accessed? 

Has the correct user name been entered? Is the user 
scheduled to take the test in the key file? 

Is the test set to only run in certain date/time bands, 
which are not current? (And tf they should be current, is 
the PC's date/time clock correct?) 

Is the test set to run only a certain number of times. or 
unttl a score has been achieved, and if so has this 
happened and so made the test no longer available? 

Is there another test of higher priority in the key file? No 
test of one priority level is done until all tests of all 
higher priorities are no longer available. 

Is the test present on disk in the correct directory (either 
the dtrectory in the key file if Use Path is set, or the 
working or \Q= di rectory otherwise)? Can it be accessed 
if it is? If Presenter cannot fi nd a test fi le, it is omitted 
frum the list. 

Either the user name is not in the key file, or the key file being 
accessed is the wrong one (see below) 

If you are referencing the key file via the /C= parameter to 
Presenter, you should check that the directory and fi le name in 
th ts parameter are correct. 

If you are relying on the key fi le being found on the working 
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Wrong test 
seems to 
run 

directory, then check the working directory is what you expect 
(check the icon properties box 10 Program Manager). 

Also check to see if there are more than one key files in the 
directory. If there is, then Presenter will use the first one in 
DOS directory order (the order you get from DOS when doing 
a DlR command). If using this method of accessing key files. 
you should usually have just one key file in a directory. 

Presenter looks for tests by DOS test file name. If you have 
two different tests with the same file name in different 
directories, then it may be that Presenter is accessing the wrong 
test. Or if you rename a test or change its internal Question 
Mark name after you add it into the key file. then this could 
cause confusion. Check carefully what is happening. 

The safest way to tell Presenter to find a test is to reference the 
test in its directory in the key file with set Use Path on. 

C.3 Problems analysing results after using 
Presenter and key file 

Answer file 
not saved 
where 
expected 

If a test specifies that answers are saved to disk, then an 
answer file is always created • the test will not run if an 
answer file cannot be made. 

The answer file is saved in the directory specified tn the key 
file under the test fi le details. The directory specified in the 
introduction page is not used; this is just the default setting 
when a new test is added to the key fil e. Any lP= parameter to 
Presenter is ignored if a key file 1s used. 
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Less data 
than 
expected in 
key file 
report 

More data 
than 
expected in 
key file 
report 

If the answer file directory in the key file IS blank (empty), then 
the answer file is saved in the Presenter working directory. 

Remember that all Guardian reports include only information 
on the users and tests selected when calling for reports. 
Information on other users and tests in the key file is not 
included To get all tnformation. select all users and all tests 

If you make a Results report and there is less information than 
you expect. consider one of the fo llowing possibilities. 

The key file could have Write results to key file set 
off, so that test results are not written to the file. 

The key file could be set to be read only, or there could 
have been some kind of d1sk error which prevented some 
results being written. 

The user did not do the test. and so there 1s no result. 

A copy has been made of the key file. and the results 
stored in the copy, not in the original file. 

Remember only to select th~ users and tests you want to repon 
on. 

You can also use Notepad or another editor or word-processor 
program to amend a report, for exam ple to cut out parts you do 
not need. 

Whenever a user selects to run a test from Presenter a result is 
saved m the key file. so the user could have attempted the test 
more than once. Even if there is an error in Presenter or in 
Wmdows, a result could be stored m U1e key file (usually with 
score 0%) 
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Problems 
accessing 
reports In 
Guardian 

When a user has taken a test, the report will still show that 
he/she is scheduled to do it (even if the test has been taken and 
is no longer available to the user). 

By default, Guardian makes a report caJied INFO.TXT and 
calls Notepad to view it. You can change how this happens via 
the Options menu. If in doubt, you can restore the default 
settings by deleting the QD_GUARD.INI file on the 
\WINDOWS directory. 

Notepad only allows you to view files that are up to 64K long 
If you have a very large report, it could be longer than this. 
You would then have to view it in a different editor. For 
example, to view the report in a word-processor, you would run 
the word-processor, choose File I Open, and select the file 
INFO.TXT (on whatever directory Guardian is using). 
Alternatively change the editor used to a program that can view 
larger tiles 
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Appendix D 

File 

User 

Reference listing of menus 
Guardian has the following menus. 

The File menu lets you create, open, save and modify key 
files. 

New 
Open 
Save 
Save As 

Password 
Introduction 

Logon messages 

Exit 

Create a new key fi le. 
Open an existing key file. 
Save the current tile. 
Save current file using a new DOS file 
name. 
Edit the key file name and password 
Set the introduction messages and 
default answer file directory. 
Set the messages used by Presenter 
asking for user name and password. 
Ex at Guardaan 

The User menu lets you add and change information about 
users in the key file lt is on ly active if the Users window is 
current 

Add 
De lete 
Edit 
Assign Group 

Sort 

Add new users into the key file. 
Delete the currently selected users. 
Edit the currently selected user. 
Assign the currently selected users to a 
user group. 
Choose from a sub-menu to sort the 
users into alphabetical order by Name 
or Group 
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Test 

Schedule 

Select group 
Select all 
Import 

Export 

Results 

Information 

Select all users in a group. 
Select all users in the key file. 
Add new users into the key file from an 
Ascii text file. 
Export information on all users in the 
key file into an Ascii text file. 
Report on the schedul ing and results of 
the currently selected users and tests. 
Report on information on the currently 
selected users. 

The Tes t menu lets you add and change information about 
tests in the key fil e. It is only active if the Tests window is 
current. 

Add 
Delete 
Edit 

Lock 

Unlock 
Select all 
Results 

Information 

Add new tests into the key tile. 
Delete the currently selected tests. 
Edit details in the key file about the 
currently selected test. 
Lock (prevent access by Designer and 
Presenter) the currently selected test 
files. 
Unlock the currently selected test files. 
Select all tests in the key file. 
Report on the scheduling and results of 
the currently selected tests and users. 
Report on information on the currently 
selected tests. 

The Sc hedule menu lets you schedule users to take tests and 
also undo the scheduling. The menu is only active if both users 
and tests are currently selected. 
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Options 

Window 

He lp 

Sche dule 

Unsc he dule 

Schedule the selected users to take the 
selected tests. 
Unschedule the selected users to no 
longer take the selected tests. 

The Options menu lets you control the way reporting works 
in Guardian and make some other preference selections. 

Editor 

Report na me 

Appe nd to re port 

VIew re po rt 
a utomatica lly 

Backup 

Ge ne rate 
passwords 

Check when 
scheduling 

Choose the editor used to view reports 
in 
Define the tile name and directory for 
the report file . 
Choose whether to append new reports 
at the end of any existing report file, or 
to overwrite old reports with new ones. 
Choose whether or not to view a report 
as soon as it is produced. 
Choose whether to make backup .Q!K 
files whenever a key file is saved. 
Choose whether to randomly generate 
passwords for new users. 
Choose whether to check to see if the 
user is already scheduled to take the test 
when scheduling. 

The Window menu lets you tile and cascade the Users and 
Tests windows or select one of them as current. 

The Help menu gives you access to the Guardian on-line help 
He lp I About shows you the version number of the software. 
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